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Notes to users Thank you for purchasing FUJI FILM Multi Gauge Ver. 2.0. Please read the following important
information carefully before using this software.

《 Before you use Multi Gauge 》
By starting to use this software, the customer consents to the following license agreement and Fuji Photo
Film Co., Ltd. allows the customer to use this software Multi Gauge.
Fuji Photo Film Co., Ltd. has the copyright of this software. Accordingly, in the scope described here,
this software is licensed to the customer by Fuji Photo Film Co., Ltd. rather than sold. While the
customer has the property rights to the recording media, the Fuji Photo Film Co., Ltd. still has the
property rights to the Multi Gauge software recorded on the media.

License terms:
1) Multi Gauge can be used in a single unit that has a single CPU or multiple CPUs. Therefore,

in a computer networking environment, Multi Gauge is necessary to each of the terminals that
use it.

2) For backup and program execution purposes, Multi Gauge may be duplicated on different
media.

Restrictions:
1) The customer may not duplicate, modify, or transfer Multi Gauge for purposes out of the

license.
2) The customer may not convert Multi Gauge to a readable form by decompiling or

disassembling.
3) The customer may not lend or distribute Multi Gauge in whole or in part for profitable

purposes.
4) The customer may not create secondary work for Multi Gauge by modifying in whole or in

part, or by combining to other software.

About this manual:
1) No part of this manual may be reproduced without permission.
2) This manual is subject to change without prior notice.
3) This manual has been developed very carefully. Please let us know if you find any

ambiguities, errors, or omissions.

This equipment is a Class 1 information device (which should be used in commerce and
industry regions) and conforms to the Voluntary Control Council for Information Technology
Equipment's (VCCI's) criteria, the objective of which is to suppress radio wave interference in
the commerce and industry region.
Accordingly, using this equipment in a residential area or its vicinity may interfere with
receivers, such as radios and televisions.
Please use this equipment correctly according to this manual.

Microsoft is a registered trademark of Microsoft Corporation in the US.
Windows®, Windows® 98SE, Windows® 2000/Service Pack 2, Windows® XP,
Windows® NT are registered trademarks of Microsoft Corporation in the US.
Pentium is a registered trademark of Intel Corporation.
Other company and product names are trademarks or registered trademarks of respective
companies.



1 "COMPANY'S LICENSOR (S)  MAKES NO WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
REGARDING THE SOFTWARE. COMPANY'S LICENSOR (S)  DOES NOT
WARRANT, GUARANTY, OR MAKE ANY REPRESENTATIONS REGARDING
THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE IN TERMS OF
ITS CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR
OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE
OF THE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF THE
IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU."

2 "IN NO EVENT WILL COMPANY'S LICENSOR (S), AND THEIR DIRECTORS,
OFFICERS, EMPLOYEES, OR AGENTS  (COLLECTIVELY "COMPANY'S
LICENSOR")  BE LIABLE TO YOU FOR ANY CONSEQUENTIAL,
INCIDENTAL, OR INDIRECT DAMAGES  (INCLUDING DAMAGES FOR LOSS
OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION, AND THE LIKE)  ARISING OUT OF THE USE OF, OR
INABILITY TO USE , THE SOFTWARE EVEN IF COMPANY'S LICENSOR HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. BECAUSE
SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE
ABOVE LIMITATIONS MAY NOT APPLY TO YOU."
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1. About Multi Gauge Ver. 2.0

1.About Multi Gauge Ver. 2.0

Multi Gauge Ver. 2.0 (also called this software) can analyze image data given by unique image

readers that Fuji Photo Film Co., Ltd. has developed as well as data in the TIFF or BMP

format.

Sample images used in this manual have been chosen so that they meet the description of the

corresponding functions. When you read this manual, replace them with appropriate images

that you actually use.

For how to capture images, see the manual that comes with each reader.

The functions of this software have been tested in the following system.

Any other configurations may not be guaranteed to run this software correctly.

1.Standard hardware configuration (environment for operation test)

PC:

DELL OptiPlex GX110-800S

(CPU: Pentium III-450 MHz, Built-in HDD: ATA33-ready EIDE drive)

(A keyboard and cable as well as a mouse and cable, which come with the PC.)

* The following main memory sizes are needed depending on kinds of images to be

analyzed. Sizes in parentheses show the maximum. Use the maximum size if you

analyze multiple kinds of images.

Peripherals:

Monitor: DELL D1025TH

(A 17-inch Trinitron monitor and cable, which comes with the PC)

SCSI board: Adaptec AVA-2930LP

MO drive: DELL optional accessory and built-in ATAPI

LBP: Canon LBP-350 (additional 16-MB memory)
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2.Standard software configuration (already checked for proper operation)

Operating system:

Japanese and English Windows® 98SE (which comes with the PC)

Japanese and English Windows® NT4.0/Service Pack 5

Japanese and English Windows® 2000/Service Pack 2

Japanese and English Windows® XP

3.Optional high-quality image output accessories

PG3000(48MB), PG3500(48MB), PG4000(120MB), PG4000II(120MB), PSD400

(With an Amphenol (Centronics) 50-pin terminator)

* For Pictrography, only one can be connected.

SCSI cable:

(The PC to Pictrography)

Sanwa Supply KB-SPC1

Centronics half-pitched 50-pin (MO side), Centronics 50-pin (Pictrography side),

1 meter long.

4.Compatibility with data derived from our other software

The compatibility between this software and our other software, Science Lab (Image Gauge,

L Process), is described below.

Image data (img and inf files) is compatible.

For image data given by Science Lab for Macintosh, you need to convert it to the Fuji

Exchange format (img and inf files) through the software.

Supplementary data for images, such as regions, annotations, and measurement data,

are incompatible with each other.

5.Memory size necessary to use this software

This software can analyze multiple images at the same time. In this case, the necessary memory

size varies depending on the number of images to be analyzed simultaneously, but it can be

guesstimated at the total size of all images plus 50 MB.

Note that an insufficient memory size or small space on the HD may cause the processing

speed to decrease or this software to fail to work.

This manual is provided for readers who have experience using Windows® and are familiar

with the basic operations and displays.

1. About Multi Gauge Ver. 2.0
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2. How to install and uninstall

2.How to install and uninstall
2.1How to install

Activate Setup.exe, which you should locate on the CD-ROM supplied. Or select Control

Panel and the Add or Remove Programs icon in turn, and then execute the installer.

Read the messages and warnings in the Welcome dialog box shown below, then click on the

button to go to the Software License Agreement dialog box.

Read the license agreement in the Software License Agreement dialog box shown below,

then click on the button, if you consent to it, to move to the Information dialog

box.
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2. How to install and uninstall

Click on the button in the Information dialog box shown below to go to the User

Information dialog box.

Input your name, company name, and the serial number which is shown on the rear of the CD-

ROM case in the User Information dialog box shown below, then click on the

button to go to the Registration Confirmation dialog box.

Check the information displayed in the Registration Confirmation dialog box for correctness,

then click on the button to advance to the Choose Destination Location dialog

box.
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2. How to install and uninstall

Click on the button in the Choose Destination Location dialog box shown

below to open the Choose Folder dialog box.

Select a desired directory, where this MultiGauge software will be installed, in the Choose

Folder dialog box shown below, then click on the button to return to the

Choose Destination Location dialog box.

Click on the button in the Choose Destination Location dialog box shown

below to go to the Select Program Folder dialog box.
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2. How to install and uninstall

Input a program folder name, which will be added to the start-up menu, in the Select Program

Folder dialog box shown below, then click on the button to go to the Start

Copying Files dialog box.

Check the user name and the directory where this software will be installed for correctness in

the Start Copying Files dialog box shown below, then click on the button.

(Now, the installation starts.)
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After the installation is complete, the Setup Complete dialog box appears as follows. Select

desired options and click on the button to end the installation.

2. How to install and uninstall
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2.2How to uninstall
Open Control Panel and double-click on the Add or Remove Programs icon.

Select MultiGauge in the dialog box shown below, then click on the button.

2. How to install and uninstall
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2. How to install and uninstall

The confirmation dialog box appears. If you wish to proceed, click on the button.

(Now, the uninstallation starts.)

The following progress dialog box appears and after the uninstallation is complete, the

button becomes active. Click on this button to finish the uninstallation.
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B

Operation Outline
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Part

B

Operation Outline

　1.　Starting up and Exitting the Software　

1.Starting up and Exitting the Software

Double-click on the Multi Gauge icon , use the short cut, or select the menu

option added to the start-up menu.

Select the Exit command from the File menu.

If you quit MultiGauge while images are displayed, the following dialog box appears.

Determine whether or not to save them.

Starting up

Exitting
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　2.　Name of each part on the window

2.Name of each part on the window
Navigation panel

Operation panel

Image window

Profile window

Result table window

Common to all the modes

Measure mode (Profile)

Analysis mode
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Part

B

Operation Outline

　3.　Operation flow with navigation　

3.Operation flow with navigation
How to use MultiGauge with navigation is described below.

* Basically, when you want to change the operation mode, select (click on) any mode button (icon) freely.
For instance, MultiGauge can change from the Display mode to the Save mode.
However, there are some restrictions. If you enter the Measure mode from the Display mode and set no measurement region, you cannot go to the

Analysis mode. Moreover, clicking on the button in the lower left position on the window allows the operation mode to change in turn.

Allows you to open and trim an image.
* When you need to analyze multiple images, open them in this mode firstly, and proceed to the next mode.

9 Print PICTRO

8 Print

7 Save mode

6 Analysis mode

5 Calibration mode

4 Measure mode

3 Annotation mode

2 Display mode

1 Image mode

Allows you to adjust the contrast of images opened and to make a crosstalk correction.

Allows you to put comments and arrows on the image.

Allows you to set measurement regions, such as lanes, bands, and titer plates.

Allows you to draw the calibration lines of concentration and molecular weight.

Allows you to display measuring results and to analyze data.

Allows you to save images and analyzing results.

Allows you to print out images and analyzing results. For this purpose, printers (LBP), the
printer drivers of which are installed, can be used.

Allows you to print out images and analyzing results through Pictrography (3000, 3500,
4000, or PSD).
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 Image Mode

First of all, select the Image mode and open an image you want to analyze.

The following three ways can be used to open the image.

1. Open the image directly.

2. Trim the image, then open the trimmed image.

3. Combine images, then open the overlaid image.

The Image mode provides the following operation panel.

Displaying an image "Image mode"

Magnify the image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Display the information of

a pixel.

Open the image file.

Trim the image.

Create overlaid images.

Proceed to the next mode.
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 Image Mode

1. Opening an image file

1. Opening an image file..........................

You can directly open the file you want to analyze.

Select the Open command from the File menu or click on the  button on the

operation panel.

Move to the directory where the desired file is saved, and then select the file format.

FUJI original files are those which are created by the following image readers:
FIJI FILM BAS series: BAS-1000, 1500, 1800, 1800II, 2000, 2500, 3000, and 5000.
FLA series: FLA-2000, 3000, 3000G, 5000, and 8000.
LAS series: LAS-1000, 1000C, 1000plus, 1000mini, and 3000.
If any Macintosh computer is used as the host of the image readers above, the
Macintosh-specific files (individual image file icons) cannot be directly analyzed by
this software. Be sure to convert them to the inf/img format.
Opening a set file created by FLA-5000 or FLA-8000 presents overlaid images.

Select the file name and click the Open button.
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 Image Mode

2. Trimming an image

2. Trimming an image.....................

You can trim part of the image you want to analyze and open the trimmed image.

Click the  button on the operation panel.

Move to the directory where the desired file is saved, and then select the file format.

Select the file name and click the Open button.

=>The Trimming dialog box is displayed.
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 Image Mode

2. Trimming an image

Drag the adjustor  in the Range Scope box to adjust the contrast.

About Range Scope
This function enables you to select the range in which image data is distributed to
enhance the contrast, resulting in the clearer image. For example, detecting very
low-intensity light biases the image data on the left side. If it is converted in a
full range of 16 bits, the contrast of the image is very low. However, narrowing
the range can make high contrasted image.

Clicking the  button displays the following dialog box, which allows you to

input numerical values directly.

Clicking the  button returns your adjustment to the original

situation.
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 Image Mode

To trim the image, adjust the trimming box in the following way. The part enclosed in the red

frame on the image window is enlarged and displayed on the Area window.

Clicking the  button displays the following dialog box, which allows you

to input numerical values directly for the width/height (pixels) of the trimming box and the

Contrast range of Range Scope (to be described later).

Click the  button in the Trimming dialog box to rotate/flip the image.

=>The Trimming Option dialog box appears.

Go to Step  if neither rotation nor flip are necessary.

Select a desired option, then click the  button.

=>The set conditions are performed and displayed in the Trimming dialog box.

2. Trimming an image

180o rotation.

90o clockwise rotation. 90o Counterclockwise rotation.

Flipping along the horizontal axis. Flipping along the

vertical axis.

Flipping along the horizontal axis

after 90o clockwise rotation.

Flipping along the horizontal axis after

90o counterclockwise rotation.

Click this button after completing settings.
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 Image Mode

2. Trimming an image

Click the  button or the  button in the Trimming dialog

box.

When you click the  button,

Only the image you want to analyze will be displayed.

When you click the  button,

The image will be displayed  with the Trimming dialog box remaining as it is.

You can continue trimming.
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 Image Mode

3. Creating overlaid images

3. Creating overlaid images...............................

You can overlay images detected on a wavelength basis and open the overlaid images.

Click the  button on the operation panel.

Click the  button of a channel you want to set and select the firse image file to

be overlaid.

In the same fashion, click the  button of a channel you want to set and select

the second image file.

:Up to three images can be composed and the overlaid images are displayed
in red, green and blue pseudo colors respectively.

Click the  button.

=>The overlaid images will be displayed.
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 Image Mode

4. Handling the image window

4. Handling the image window
You can magnify and reduce the image being displayed and also switch the view of images.

Magnify and reduce the image being displayed (  on the control panel)

The magnifying glass tools  allow you to magnify and reduce the image being

displayed respectively.

Magnifying

Select the  tool (click this icon).

After the mouse cursor changes to ,  move it to the center of a place you want to

magnify and click.

Reducing

Select the  tool (click this icon).

After the mouse cursor changes to ,  move it to the center of a place you want to

reduce and click.

Scrolling the image being displayed (  on the control panel)

When only part of the image is displayed in the image window, the hand tool  enables you

to scroll the image.

Select the  tool (click this icon).

After the mouse cursor changes to  , move it in the image window and drag the cursor.

The displayed image is scrolled with the cursor.

Or, move the  cursor in the Display window and drag the red edge frame.
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 Image Mode

Switching the view of overlaid images
Use the  or  button in the upper part of the image window to switch between

overlaid images and individual images.

Overlap

Each

4. Handling the image window
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 Image Mode
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 Display Mode

Next, adjust the contrast of the opened image in the Display mode.

The Display mode provides the following operation panel.

Changing the view of an image "Display mode"

Magnify the image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Display the information

of a pixel.

Color icon: Change the display color.

The appearance of this icon varies depending

on a single, individual, or overlaid image(s).

Correct the crosstalk.

Enhance the contrast.

Proceed to the next mode.

Adjust  the contrast.
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 Display Mode

1. Changing the display color

1. Changing the display color.................................. Display color
This option allows you to change the color of an image you want to display.

Click the image window you want to change.

=>The window chosen becomes active.

Click the desired color icon on the operation panel. For overlaid images, click on the 

icon.

=>The image display color changes.

Single image (when an img/inf file or a tiff file is chosen)

Individual images (when a set file is opened or when images are opened

by Compose function and the Each button is pressed)

Overlaid images (when a set file is opened or when images are opened

by Compose function). Select a file name to which you want to assign

each color, then click the  button.
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 Display Mode

2. Enhancing the contrast

2. Enhancing the contrast....................... Range Scope
This function allows you to select a range in which image data is distributed to enhance the contrast, resulting in the clearer

image.
Click the image window you want to change.

=>The window chosen becomes active.

Click the  button on the operation panel.

=>The Range Scope dialog box is displayed.

About Range Scope
The function enables you to select the range in which image data is distributed to
enhance the contrast, resulting in the clearer image. For example, detecting very
low-intensity light biases the image data on the left side. If it is converted in a full
 range of 16 bits, the contrast of the image is very low. However, narrowing the

range can make high contrasted image.
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 Display Mode

2. Enhancing the contrast

Drag the adjuster  on the Range Scope box to set the desired range.

Clicking the  button displays the following dialog box, which allows you to

input numerical values directly.

Click on the  button.
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 Display Mode

According to which one of the tone curves you select, the appearance of images changes  much.

3. Adjusting the contrast

3. Adjusting the contrast...........................Contrast
This option allows you to use the tone curve and adjust the contrast of the image.

Click the image window you want to change.

=>The window chosen becomes active.

Select the desired tone curve from the Scale Type pull-down menu on the operation panel.

Exponential..... Adjusts the contrast based on an exponential tone curve.

Linear..............Adjusts the contrast based on a linear tone curve.

Sigmoid...........Adjusts the contrast based on a Sigmoid tone curve.

Bezier..............Adjusts the contrast based on a Bezier tone curve.

Exponential

Linear

Sigmoid

Bezier

Adjusting the contrast with an Exponential curve is available.
This is useful for creating an image with the low background.
Dragging the adjuster  reflects the image contrast in real time.
As the E slide bar is approaching the right end, the slope of the curve is
increasing and the background becomes lower.
* In the case of overlaid images, you can adjust the contrast on individual
images basis.

Adjusting the contrast with a Linear tone curve is available.
This is useful for images with gradations.
Dragging the adjuster  reflects the image contrast in real time.
* In the case of overlaid images, you can adjust the contrast on individual
images basis.

Adjusting the contrast with a Sigmoid tone curve is availavle.
This is useful for creating a film-like image.
Dragging the adjuster  reflects the image contrast in real time. As the S
slide bar approaches the right end, the slope of the curve increases.
* In the case of overlaid images, you can adjust the contrast on individual
images basis.

Adjusting the contrast with a Bezier tone curve is available.
Moving the mouse cursor onto any point of the Bezier curve and dragging
it can change the shape of the curve, which causes the contrast of an
image to change freely. Dragging the adjuster reflects the image
contrast in real time.
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 Display Mode

4. Crosstalk correction

4. Crosstalk correction................... Crosstalk
This option allows you to correct the effect of fluorescent overlap between colors and convert the image to the quantitative

one. It is available only for overlaid images.

Click the  button on the operation panel.

=>The Crosstalk Confirmation dialog box is displayed.

Click the window including overlaid images to make it active.

Drag the mouse to create control specification frame and background specification frame on

the overlaid images.

Click the Crosstalk Confirmation dialog box to make it active.
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 Display Mode

4. Crosstalk correction

Click the  button on the Crosstalk Confirmation dialog box.

=>A dialog for saving the corrected file is displayed.

Input a file name, then click the  button.

=>The crosstalk correction is executed.

About crosstalk
When the image of gels or membranes marked with multiple fluorescent pigments
is captured, the pigments may not be distinguished due to a fluorescent overlap,
that is the image of one pigment component is affected by other pigment
components. This phenomenon is called crosstalk.



2002. Oct. Ver.3.0C-18

 Display Mode

5. Handling the image window

5. Handling the image window
You can magnify and reduce the image being displayed and also switch the view of images.

Magnify and reduce the image being displayed (  on the control panel)

The magnifying glass tools  allow you to magnify and reduce the image being

displayed respectively.

Magnifying

Select the  tool (click this icon).

After the mouse cursor changes to ,  move it to the center of a place you want to

magnify and click.

Reducing

Select the  tool (click this icon).

After the mouse cursor changes to ,  move it to the center of a place you want to

reduce and click.

Scrolling the image being displayed (  on the control panel)

When only part of the image is displayed in the image window, the hand tool  enables you

to scroll the image.

Select the  tool (click this icon).

After the mouse cursor changes to  , move it in the image window and drag the cursor.

The displayed image is scrolled with the cursor.

Or, move the  cursor in the Display window and drag the red edge frame.
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Switching the view of overlaid images
Use the   or   button in the upper part of the image window to switch between

overlaid images and individual images.

Overlap

Each

5. Handling the image window
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 Annotation Mode

The Annotation mode allows you to add arrows, comments, and file information on the

image. It provides the following operation panel.

Writing comments on an image "Annotation mode"

Magnify the image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Display the information

of a pixel.

Arrow tool

Text tool

Scale Bar tool

Proceed to the next mode.

Pointer tool

Information tool
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1. Drawing arrows

1. Drawing arrows
You can put arrows on an image.

Click the image window on which you want to put an arrow.

=>The window chosen becomes active.

Click the Arrow tool  on the operation panel.

Set the attributes of the arrow.

First, determine the start point of the arrow on the image and press the mouse button. Next,

determine the length and direction of the arrow and drag the mouse cursor. Finally, release the

mouse button at the end point.

Ex.: Size: 1, Pattern:   , and Color: 
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2. Moving, Changing attributes, or deleting the arrow

2. Moving, Changing attributes, or deleting the arrow
You can move or delete the arrow already added, or can change the attributes of it.

How to move
Click the image window on which an arrow you want to move.

=>The window chosen becomes active.

Click on the pointer tool  on the operation panel.

Place the mouse cursor onto the arrow and press the mouse button.

=>The arrow is highlighted (enveloped in a red color frame).

Move the mouse cursor into the red color frame, and after checking that the cursor form

changes to  , drag it to a desired position.

How to change the attributes
Click the image window to change any attribute of the arrow.

=>The window chosen becomes active.

Click the selection tool  on the operation panel.

Move the mouse cursor onto the arrow and double-click.

=>The Annotation Arrow dialog box is displayed.

Change any attributes and click the  button.

How to delete
Click the image window on which an arrow you want to delete.

=>The window chosen becomes active.

Click the pointer tool  on the operation panel.

Move the mouse cursor onto the arrow and press the mouse button.

=>The arrow is highlighted (enveloped in a red color frame).

Press the Delete key on the keyboard.
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3. Writing comments

3. Writing comments
You can put comments on an image.

Click the image window on which you want to put a comment.

=>The window chosen becomes active.

Click the text tool  on the operation panel.

Set the attributes of the comment.

Move the mouse cursor into the window and click on a point where the comment is to be put.

=>The Input Text dialog box is displayed.

Input the comment and click the  button.

=>The comment is displayed on the image.

Ex.: Font: Courier New, Style: Bold, Size: 10, Color:  ,

and Back:

Set a font.
Select any font from the pull-down
menu.

Set a style.
Select any style from the pull-down
menu.

Set a size.
Select any size from the pull-down
menu.

Set a color.
Select any color from the pull-down
menu.

Set a background color.
Select any color from the pull-down
menu.
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4. Moving, Changing attributes, or deleting the comment

4. Moving, Changing attributes, or deleting the comment
You can move or delete the comment already added, or can change the attributes of it.

How to move
Click the image window on which a comment you want to move.

=>The window chosen becomes active.

Click the pointer tool  on the operation panel.

Move the mouse cursor onto the comment and press the mouse button.

=>The comment is highlighted (enveloped in a red color frame).

Move the mouse cursor into the red color frame, and after checking that the cursor form

changes to  , drag it to a desired position.

How to change the attributes
Click the image window to change any attribute of the comment.

=>The window chosen becomes active.

Click the selection tool  on the operation panel.

Move the mouse cursor onto the comment and double-click.

=>The Annotation Text dialog box is displayed.

Change any attributes and click the  button.

How to delete
Click the image window on which a comment you want to delete.

=>The window chosen becomes active.

Click the pointer tool  on the operation panel.

Move the mouse cursor onto the comment and press the mouse button.

=>The comment is highlighted (enveloped in a red color frame).

Press the Delete key on the keyboard.
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5. Pasting an information file

5. Pasting an information file
You can paste image information, such as reading conditions, on the image.

Click the information tool  on the operation panel.

Click the desired point on the image where the information file is pasted.

=>The Select Info Stamp Items dialog box is displayed.

Check any items you want to paste.

Click the  button.

=>The information is displayed image.
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6. Moving, Changing attributes, or deleting the information file

6. Moving, Changing attributes, or deleting the information file
You can move or delete an information file already pasted, or can change the contents being displayed.

How to move
Click the selection tool  on the operation panel, then move the mouse cursor onto an

information stamp pasted and press the mouse button.

=>The information is highlighted (enveloped in a red color frame).

Move the mouse cursor into the red color frame.

=>The cursor form changes to the hand tool    .

Drag the information to the desired position and release the mouse button.

How to Change the attributes
Click the pointer tool  on the operation panel, then move the mouse cursor onto an

information stamp pasted and double-click.

=>The Annotation Info Stamp dialog box is displayed.

Change any attributes and click the  button.

How to delete
Click the pointer tool  on the operation panel, then move the mouse cursor onto an

information stamp pasted and press the mouse button.

=>The information is highlighted (enveloped in a red color frame).

Press the Delete key on the keyboard.

=>The information file is deleted.
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7. Pasting a scale bar
You can paste a scale bar on the image.

Click the scale bar tool  on the operation panel.

Set the attributes of a scale bar by selecting each option on the operation panel.

Click the desired point on the image where the scale bar is pasted.

=>The Annotation Scalebar dialog box is displayed.

Enter a length and select a unit. If you want to give edges to the scale, check the Draw edge

lines check box.

Click the  button.

=>The scale bar is displayed on the image.

7. Pasting a scale bar

Scale bar width

Text size

Text and scale bar color

Background color

Text alignment
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8. Moving, Changing attributes, or deleting the scale bar

8. Moving, Changing attributes, or deleting the scale bar
You can move or delete the scale bar already pasted, or can change the attributes of it.

How to move
Click the pointer tool  on the operation panel, then move the mouse cursor onto the

scale bar pasted and press the mouse button.

=>The scale bar is highlighted (enveloped in a red color frame).

Move the mouse cursor into the red color frame.

=>The cursor form changes to the hand tool   .

Drag the scale bar to a desired position and release the mouse button.

How to change the attributes
Click the selection tool  on the operation panel, then move the mouse cursor onto an

scale pasted and double-click the mouse button.

=>The Scalebar Item Settings dialog box is displayed.

Change any attributes and click the  button.

How to delete
Click the pointer tool  on the operation panel, then move the mouse cursor onto an

scale bar pasted and press the mouse button.

=>The scale bar is highlighted (enveloped in a red color frame).

Press the Delete key on the keyboard.

=>The scale bar is deleted.
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The Measure mode allows you to quantify the image.
The following three options are available to set the quantifying region.

1.Quant
This option allows you to set the region so that it fits the shape of a sample.
Specifying the background region gives a quantitative value from which the
background is subtracted.

2.Profile
This option allows you to create the profile region in the migrating direction.
For the background, any of Horizontal Line, Polygonal Line, and Spline can be speci
fied.

3.Plate
This option allows you to easily set the region of a titer plate.
For the background, a blank well can be specified.

In this mode, you can also measure distances and angles.
1.Distance

This option allows you to measure the diameter of a circle, the distance between
points specified, and angles.

The Measure mode provides this operation panel. Select a desired tab to make the corresponding
measurement.

　 　Quantifying the image "Measure mode"

< Quant > < Profile > < Plate > < Distance >

Pointer tool

Roi tools

BG tools

Sorts region
numbers.

Lane creation tool

Lane position
adjusting tool

Display a profile.

Pointer tool

Select a well type.
Select  the orientation
of a plate.
BG tools

Sort  region numbers.

Set the conditions
of a plate.

Pointer tool

Sort  region numbers.

Measurement tool
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　1.　Quantitative analysis with a quantifying region

1. Quantitative analysis with a quantifying region........... "Quant"
1-1. Creating a quantifying region

The Quant option allows you to set a region having an arbitrary shape.

Click the Quant tab on the operation panel.

Click any of the Roi tools that meets the shape you want to create.

Click the desired image window to make it active.

Create a region on the image.

Rectangle tool

①Click the upper left ②Drag to the lower right ③Release the mouse
　corner of a region you 　corner. 　button.
　want to create.

Oval tool

①Click the upper left of a ②Drag to the lower right ③Release the mouse
　region you want to create. 　corner. 　button.

Polygon tool

①Click a corner of polygon, ② Repeat Step ① . ③Double-click the
　then drag to the next corner. 　 　last corner.
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　1.　Quantitative analysis with a quantifying region　

Freehand tool

①Click the first point. ②Drag the cursor to draw an ③Release the mouse
　 　desired region. 　button.

Slanted
rectangle tool

①Click the first point, then ②Drag in the direction of ③Click the last point.
　drag in the direction of one 　the other side.
　side and release the mouse
　button.

Ladder tool

①Click the first point, then ②Drag in the lane width ③Click a point through ④Double-click the
　drag in the migrating 　direction and release the 　which a division line is 　last point.
　direction and release the 　mouse button. 　drawn and repeat it.
　mouse button.

Magic  Wands
 tool

①Move the cursor onto the ②Release the mouse button.
　outline of an region,
　then click and drag.

Free edit
tool

①Select the pointer tool, ②Select the free edit tool, ③Double-click the
　then click on an area you 　then drag the cursor to draw 　area  you want to
　want to split. 　a division line. 　keep.
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　1.　Quantitative analysis with a quantifying region

1-2. Modifying, moving, or deleting the quantifying region
The Quant option allows you to modify, move, or delete the quantifying region.

Click the Quant tab on the operation panel.

Click the pointer tool   on the operation panel.

Click the quantifying region you want to change.
=>The region chosen is turned red.
The modifying way depends on a Roi tool with which the region was created.

Rectangle tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

Oval tool

Slauted
rectangle tool

Ladder tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　the lower right point to be 　drag to a desired point. 　button.
　changed.
→The cursor form changes to .

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　the upper right point to be 　drag to a desired point. 　button.
　changed.
→The cursor form changes to .

Modifying the quantifying region

Magnify or reduce



Part

C

Operation Details

2002. Oct. Ver.3.0 C-35

 Measure Mode

　1.　Quantitative analysis with a quantifying region　

Polygon tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

Freehand tool

Magic Wands
tool

Slanted
rectangle tool

Ladder tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　the lower left point to be 　drag rotationally. 　 　button.
　 changed.
→The cursor form changes to .

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　the lower left point to be 　drag rotationally. 　 　button.
　 changed.
→The cursor form changes to .

Shape change

Rotation
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　1.　Quantitative analysis with a quantifying region

How to move division lines

How to add division lines

How to delete division lines

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any division line you want to 　drag the line in parallel. 　button.
　change.
→The cursor form changes to .

①Hold the Ctrl key down and ②Press the mouse button and ③Release the mouse
　move the cursor onto a desired 　drag the cursor with the Ctrl 　button.
　point of the region's outline. 　key held down to draw the
→The cursor form changes to .　horizontal line.

①Hold the Shift key down and ②Press the mouse button with
　move the cursor onto a division　the Shift key held down.
　line you want to delete.
→The cursor form changes to .

Modify Division lines of a ladder region
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　1.　Quantitative analysis with a quantifying region　

Moving the quantifying region
Click the Quant tab on the operation panel.

Click the pointer tool   on the operation panel.

Click the region you want to move.
=>The region chosen is turned red.

Move the mouse cursor in the region, drag to the desired position and release the mouse
button.

Deleting the quantifying region
Click the Quant tab on the operation panel.

Click the pointer tool   on the operation panel.

Click the region you want to delete.
=>The region chosen is turned red.

Press the Delete key on the keyboard.
=>The region is deleted.
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　1.　Quantitative analysis with a quantifying region

1-3. Creating a background region
The Quant option allows you to set a background region on the image.

Click the Quant tab on the operation panel.

Select a background shape you want to create from the BG tools on the operation panel.

Click the desired image window to make it active.

Create a region on the image.
=>The resulting background region is displayed in purple.

BG rectangle
tool

①Click the upper left ②Drag to the lower right ③Release the mouse
　corner of the region you 　corner. 　button.
　want to create.

BG oval tool

①Click the upper left of ②Drag to the lower right ③Release the mouse
　the region you want to create.　corner. 　button.

BG polygon tool

①Click a corner of  polygon, ② Repeat Step ① . ③Double-click the
　then drag to the next corner. 　 　last corner.

BG slanted
rectangle tool

①Click the first point, then ②Drag in the direction of ③Click the last point.
　drag in the direction of one 　the other side.
　side and release the mouse
　button.
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1.　Quantitative analysis with a quantifying region　

1-4. Modifying, moving, or deleting the background region
The Quant option allows you to modify, move, or delete a background region.

Click the Quant tab on the operation panel.

Click the pointer tool   on the operation panel.

Click the background region you want to change.
=>The region chosen is turned red.
The modifying way depends on a BG tool with which the region was created.

BG rectangle
 tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

BG oval tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

BG slanted
rectangle tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　the lower right point to be 　drag to a desired point. 　button.
　changed.
→The cursor form changes to .

BG polygon
tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

Magnify or reduce

Shape change
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Moving the background region
Click the Quant tab on the operation panel.

Click the pointer tool   on the operation panel.

Click a region you want to move.
=>The region chosen is turned red.

Click the region, drag to a desired position, and release the mouse button.

Deleting the background region
Click the Quant tab on the operation panel.

Click the pointer tool   on the operation panel.

Click a region you want to delete.
=>The region chosen is turned red.

Press the Delete key on the keyboard.
=>The background region is deleted.

　1.　Quantitative analysis with a quantifying region

BG slanted
rectangle tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　the lower left point to be 　drag rotationally. 　 　button.
　 changed.
→The cursor form changes to .

Rotation
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　2.　Quantitative analysis with a profile

2. Quantitative analysis with a profile.................. "Profile"
2-1. Creating a profile region

The Profile option allows you to set a profile region in the migrating direction.

Click the Profile tab on the operation panel.

Click the lane tool  on the operation panel.

Input the number of lanes within an image to be analyzed in the Lane Count box.

Click the  button.
=>Lanes of an arbitrary size is displayed on the image.

:At this time, the lane position adjusting tool  is automatically chosen in
the Lane field.
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2.　Quantitative analysis with a profile　

Adjust the resulting profile region to the image.
1.Drag the handles (circles) at the four corners of the lane set respectively to the
   corners of the image pattern.

When the image is curved
(How to modify all the lanes)

(1) Move the mouse cursor into the lane at the left or right far end (Lane 1 or Lane 6 of
      the accompanying sample figure) and double-click the mouse button.
      => The curve handles (circles) appear in the lanes at both ends.

(2) Fit the lane set to the curve of the real image by dragging each of the curve handles
      in the vertical and horizontal directions.

:To delete the curve handles, press the Delete key on the keyboard with the
handles chosen (red circles).
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　2.　Quantitative analysis with a profile

(How to modify the specific lane)
(1) Move the mouse cursor into the lane you want to curve and double-click the mouse
       button.
      =>The curve handle (circle) is displayed in the lane chosen.
(2) Fit the lane to the curve of the real image by dragging the curve handle in the vertical
      and horizontal directions.

:This software may not allow you to curve each of the lanes at both ends
 independently.

2.Adjust the distance between lanes
　Move the mouse cursor into the lane you want to move and drag it.
     =>Only the lane chosen moves.

:This method cannot apply to the lanes at both ends. Move them by dragging
the handles (circles) of the lane set at the four corners.
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2.　Quantitative analysis with a profile　

3.Adjust the lane width.
(1) Click the lane.
      => The lane chosen is tuned red.
(2) Move the mouse cursor onto the right or left line of the lane.
      =>The cursor form changes to  .
(3) Drag the mouse cursor to adjust the lane width.

: This method applies to all the lanes displayed.

With the cursor form being , double-clicking the mouse button allows you to
input a numerical value for the lane width. This function is useful when the
migrating width is known.

: To recreate the profile region, click the  button to start over.
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　2.　Quantitative analysis with a profile

2-2. Displaying a profile
The Profile option allows you to display the profile in the lanes already specified.

Click the Profile tab on the operation panel.

Click the  button on the operation panel.
=>The Profile window is displayed.

Click the Profile window to make it active.
=>The operation panel changes as follows.

　　　（Single image）　　 　　 （Individual or overlaid images）
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2.　Quantitative analysis with a profile　

Click any of the lanes displayed on the lower pare of the Profile window.
=>The profile of the lane chosen is displayed on the upper pane.

Holding the Shift or Ctr key down and clicking allows you to select multiple lanes
and to display the profiles simultaneously.
For individual or overlaid images, the profiles of each channel (images used for
 composition) are overlaid and displayed in different colors.

　　

（Single image）

（Individual or overlaid images）
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　2.　Quantitative analysis with a profile

2-3. Setting bands
The Profile option allows you to set bands for quantification.
Two setting methods are available: automatic recognition and manual setting.

（Automatic recognition）
Click the Profile tab on the operation panel.

Click the  button in the Band field of the operation panel.
The bands of all image lanes displayed in the lower part of the window are recognized
automatically and displayed  on the profiles.

: The automatic recognition takes place for all the lanes.

（Single image）

（Individual or overlaid images）
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The view of bands recognized can toggle between the regional and positional types.
Check the Display option in the Band field of the operation panel, then click either
of the corresponding two buttons.

Deselecting the Display option, the band view is not displayed. This function is useful
for re-checking the profile shape.

2.　Quantitative analysis with a profile　

…Regional type (displays band widths detected.)

…Positional type (displays peaks detected.)
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（Manual setting）
Check the Display option in the Band field of the operation panel.

Select either of the view types  and  .

: Even after the setup is complete, clicking on either button can change the
band view.

Click   button in the Band field of the operation panel.

Click the lane of a profile for which bands are specified to display the profile.

Move the mouse cursor close to the band peak on the profile graph.

Set a band.

Regional type  : Start dragging the mouse cursor from the left end of the band
you want to set and release the mouse button at the right end.

Positional type  : Click the mouse button near the band peak.

　2.　Quantitative analysis with a profile
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2.　Quantitative analysis with a profile　

2-4. Modifying or deleting the band
The Profile option allows you to modify or delete the band already specified.

（When the band view is regional type）
You can change the band width.

Click the Profile tab on the operation panel.

Click the  button in the Band field of the operation panel.

Place the mouse cursor onto the left most or right most line of the band.

=>The cursor form changes to .

Drag the mouse cursor to change the band width.

（When the band view is positional type）
You can change position of the peak position indication line.

Click the Profile tab on the operation panel.

Click the  button in the Band field of the operation panel.

Place the mouse cursor onto the peak position indication line already specified.
=>The cursor form changes to the character B.

Drag the mouse cursor to change the position of the peak position indication line.

Modifying a band
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Click the Profile tab on the operation panel.

Click the  button in the Band field of the operation panel.

Click anyplace in the band or the vicinity of the peak position indication line.
=>The band or line chosen is turned red.

Press the Delete key on the keyboard.

　2.　Quantitative analysis with a profile

Deleting the band
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2.　Quantitative analysis with a profile　

2-5. Setting a background
The Profile option allows you to set the background of the profile.
Two setting methods are available: automatic recognition and manual setting.
For a overlaid image, you can set backgrounds on individual images.

（Automatic recognition）
Click the Profile tab on the operation panel.

Select a background type from the Form pull-down menu in the Background field of the
operation panel.

Click the  button in the Background field of the operation panel.

=>If you select Horizontal Line, the backgrounds of all image lanes are recoguized
automatically and displayed on the profile graph.

=>If you select either of Polygonal Line and Spline, the following dialog box is displayed.

Horizontal Line ........... Horizontal Line
Polygonal Line ........... Polygonal Line (broken line)
Spline ....................... Spline (curved line)
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If you select either of Polygonal Line and Spline, input values in percent for the automatic
recognition parameters H.Ratio (A/B) and V.Ratio (C/D).

　　About the H.Ratio (A/B) and V.Ratio (C/D) parameters

　　The H.Ratio (A/B) parameter specifies the extent to which a valley between peaks is detected.
　　The smaller the value, the shallower the valley able to be detected, which allows the background to
　　be specified with respect to smaller peaks. This parameter is specified as the ratio (percent) of the
　　distance between valleys to the full length of a profile.

　　Ex.: Line A is drawn if the ratio of the distance between valleys to the full length of a profile is 10
　　　　percent or less, while Line B is drawn if larger.

　　The V.Ratio (C/D) parameter specifies the extent to which valleys are detected with respect to the
　　amplitude of peaks. The smaller the value, the lower the peaks, which allows valleys between them
　　to be detected. This parameter is specified as the ratio of a profile height to the maximum amplitude
　　(vertical) of a profile created.

　　Ex.: Line A is drawn if the ratio of a profile height to the maximum amplitude of a profile is 70 percent
　　　　or less, while Line B is drawn if larger.

　2.　Quantitative analysis with a profile
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2.　Quantitative analysis with a profile　

Click the  button.
=>The background of all image lanes are recoguized automatically and displayed on the
profile graph.
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　2.　Quantitative analysis with a profile

（Manual setting）
Click the Profile tab on the operation panel.

Select a background type from the Form pull-down menu in the Background field of the
operation panel.

For overlaid images, click the icon of the channel for which the background is specified.
(Click the color of the target channel icon.)
For a single image, go to Step  .

Click the background creation tool  in the Background field of the operation panel.

Create the background by clicking on the profile graph.
The creation method varies depending on the background type selected in the Form box.

Horizontal Line ........... Horizontal Line: Click anywhere on the profile graph to display a

horizontal background line, then drag it to set vertical position.

Horizontal Line ........... Horizontal Line
Polygonal Line ........... Polygonal Line (broken line)
Spline ....................... Spline (curved line)
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Polygonal Line .............First, click a desired point on the left end of the profile graph. The start
point is displayed. Next, click on points one after another toward the right
end. Finally, double-click a desired point on the right end of the profile
graph.

Spline .......................... In the same manner as the Polygonal Line, set the background curve.

2.　Quantitative analysis with a profile　
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　2.　Quantitative analysis with a profile

2-6. Modifying or deleting the background
The Profile option allows you to modify or delete the background already specified.

How to Modify
Click the Profile tab on the operation panel.

Click the  button in the Background field of the operation panel.

Place the mouse cursor on the background line (for Horizontal Line) or the point of the
background curve (for Polygonal Line/Spline).
=>The cursor form changes to BG.

Drag the mouse cursor to change the background.
Horizontal Line .............Place the mouse cursor onto the horizontal line, after the mouse cursor form

changes to BG, drag it to adjust the vertical position.

Polygonal Line/Spline.....Place the mouse cursor onto any point of the polygonal line/spline, after the
cursor form changes to BG, drag it to adjust the point position.

How to delete
Click the Profile tab on the operation panel.

Click the  button in the Background field of the operation panel.

Move the mouse cursor to the vicinity of the background you want to erase, and after the
cursor form changes to GB, click the mouse button.
=>The background is highlighted in red.

Press the Delete key on the keyboard.
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 　3.　Quantifying a titer plate

3. Quantifying a titer plate......................."Plate"
3-1. Setting the parameters of a template

The Plate option allows you to set the shape of a template you want to create.

Click the Plate tab on the operation panel.

Click the  button on the operation panel.

=>The Plate Setting dialog box is displayed.

Click the tab corresponding to the shape of the template you want to create.
96Well..................... Uses a 96-holes titer plate.
384Well.................. Uses a 384-holes titer plate.
Custom-Well...... Uses a custom-made plate.

Set the parameters for the plate chosen.

（96Well）
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（384Well）

（Custom-Well）

Click the  button.

3.　Quantifying a titer plate　



2002. Oct. Ver.3.0C-62

 Measure Mode

　3.　Quantifying a titer plate

3-2. Creating a template
The Plate option allows you to create the template on the image.

Click the Plate tab on the operation panel.

Select a well type.

Select a plate orientation.

The  button………Horizontal plate

The  button………Vertical plate

Click the plate center on an image.
=>The template is displayed in red.

Drag the template to adjust the position, then release the mouse button.
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3.　Quantifying a titer plate　

3-3. Modifying or deleting the template
The Plate option allows you to adjust position by rotation, or change the attributes, or move and delete the template
already specified.

How to adjust position
Click the Plate tab on the operation panel.

Click the pointer tool  on the operation panel.

Click the template on the image.
=>The template is turned red.

Place the mouse cursor onto the lower right point to be changed.
=>The mouse cursor form changes to  .

Press the mouse button at the point, drag rotationally, and release the mouse button.

How to change attribute
Click the Plate tab on the operation panel.

Click the pointer tool  on the operation panel.

Double-click the template on the image.
=>The Plate Setting dialog box is displayed.

Change any attributes, then click the  button.
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　3.　Quantifying a titer plate

How to move
Click the Plate tab on the operation panel.

Click the pointer tool  on the operation panel.

Click the template on the image.
=>The template is turned red.

Click the template, drag to a move position, and release the mouse button.

How to delete
Click the Plate tab on the operation panel.

Click the pointer tool  on the operation panel.

Click thetemplate on the image.
=>The template is turned red.

Press the Delete key on the keyboard.
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3.　Quantifying a titer plate　

3-4. Setting a background
The Plate option allows you to set a background on the image and on the well of the template.

Click the Quant tab on the operation panel.

Select the background shape you want to create from the BG tools on the operation panel.

Click the image window to make it active.

Create the backgound region on the image.
=>The resulting background region is displayed in purple.

BG rectangle
 tool

①Click the upper left ②Drag to the lower right ③Release the mouse
　corner of the region 　corner. 　button.
　you want to create.

BG oval tool

①Click the upper left of the ②Drag to the lower right ③Release the mouse
　region you want to create. 　corner. 　button.

BG polygon tool

①Click a corner of polygon, ② Repeat Step ① . ③Double-click the
　the drag to the next corner. 　 　last corner

BG slanted
rectangle tool

①Click the first point, then ②Drag in the direction of ③Click the last point.
　drag in the direction of one 　the other side.
　side and release the mouse
　button.

Setting a background on the image
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　3.　Quantifying a titer plate

Setting a well background
Click the Plate tab on the operation panel.

Move the mouse cursor onto the well you want to set as the background, then press the right
mouse button.
=>The Attribute menu is displayed for the well.

Select the BG command from the Attribute menu.
=>The well is turned purple and set as the background.
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3.　Quantifying a titer plate　

3-5. Modifying, moving, or deleting the background
You can magnify/reduce, modify by rotation  move, or delete the template already specified.

Click the Quant tab on the operation panel.

Click the pointer tool  on the operation panel.

Click the background region you want to change.
=>The region chosen is turned red.
     The modifying way depends on the BG tool with which the region was created.

BG rectangle
 tool

BG oval tool

BG slanted
rectangle tool

BG polygon
tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

＜Background set on the image＞

Magnify or reduce

Shape change

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　any point you want to change. 　drag to a desired point. 　button.
→The cursor form changes to .

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　the lower right point to be 　drag to a desired point. 　button.
　changed.
→The cursor form changes to .
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How to move
Click the Quant tab on the operation panel.

Click the pointer tool   on the operation panel.

Click a region you want to move.
=>The region chosen is turned red.

Click the region, drag to a desired position, and release the mouse button.

How to delete
Click the Quant tab on the operation panel.

Click the pointer tool   on the operation panel.

Click the region you want to delete.
=>The region chosen is turned red.

Press the Delete key on the keyboard.
=>The background region is deleted.

BG slanted
rectangle tool

①Move the mouse cursor onto ②Press the mouse button and ③Release the mouse
　the lower left point to be 　drag rotationally. 　 　button.
　 changed.
→The cursor form changes to .

　3.　Quantifying a titer plate

Rotation
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3.　Quantifying a titer plate　

＜Background set on the well＞
Click the Plate tab on the operation panel.

Move the mouse cursor onto the well background you want to change, then press the right
mouse button.
=>The Attribute menu is displayed for the well.

Select the Normal command from the Attribute menu.
=>The well is turned blue.
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4.　Measuring distances or angles　

4. Measuring distances or angles............... "Distance"
4-1. Creating measurement lines

The Distance option allows you to create lines on the image for measurement.

Click the Distance tab on the operation panel.

Click any of the measurement tools you want to use.

Click the desired image window to make it active.

Create the measurement line on the image.

Distance
 tool

①Click the mouse button at the ②Click the mouse button at the ③Double-click the mouse
　first point, then move the cursor 　second point you want to measure, 　button at the last point.
　in a measuring direction. 　then move the cursor in a measuring

　direction. Repeat this operation.

Interval
 tool

①Click the mouse button at the ②Click the mouse button at the
　first point, then move the cursor 　last point.
　in a measuring direction.

Angle
 tool

①Click  three points so that a
　measured angle is formed.
　=>The interior angle is measured.
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4.　Measuring distances or angles

4-2. Modifying, moving, or deleting the measurement line
The Distance option allows you to modify, move, or delete the measurement line already drawn on the image.

Click the Distance tab on the operation panel.

Click the pointer tool   on the operation panel.

Click the measurement line you want to change.
=>The line chosen is turned red.

Move the cursor onto a point to be changed. The mouse cursor form changes to  .
Click the point, drag to a desired point, and release the mouse button.

Distance
tool

①Move the cursor onto the point ②Press the mouse button, then ③Release the mouse
　you want to change. 　drag to the desired point. 　button.

Interval
 tool

Angle
 tool

Modifying

①Move the cursor onto the point ②Press the mouse button, then ③Release the mouse
　you want to change. 　drag to the desired point. 　button.

①Move the cursor onto the point ②Press the mouse button, then ③Release the mouse
　you want to change. 　drag to the desired point. 　button.
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Click the Distance tab on the operation panel.

Click the pointer tool  on the operation panel.

Click the measurement line you want to move.
=>The line is turned red.

Click the measurement line, drag to a desired point, and release the mouse button.

Click the Distance tab on the operation panel.

Click the pointer tool  on the operation panel.

Click the measurement line you want to delete.
=>The line is turned red.

Press the Delete key on the keyboard.

4.　Measuring distances or angles　

How to delete

How to move
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The Calibration mode allows you to set a calibration curve (calibration) for measuring

molecular weight, isoelectric points, or band concentration. Parameters able to be

specified vary depending on the quantifying modes.

Quant Used for measuring band concentration.

profile Used for measuring band concentration, molecular weight, and

isoelectric points.

Plate Used for measuring titerplate concentration.

Distance No setup.

Calibration mode provides the following operation panel.

Creating a calibration curve "Calibration mode"

< Profile> <Quant> < Plate >

Standard band selection tool

Standard band unit.

Makes calibration.

Standard unit of

molecular weight.
Standard lane selection tool

Makes calibration.

Standard band
selection tool

Standard
band unit.

Makes calibration.

Standard band
selection tool

Standard
band unit.

Makes calibration.
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1. Molecular weight and isoelectric point calibration

1. Molecular weight and isoelectric point calibration
You can set the lane as standard.

Click the Profile tab, one of the quantifying modes.

Place the mouse cursor into the Mol. Wt. text box in the Mol. Wt. Calib. field, then input a

unit.

Click the  button under Select STD Lane in Mol. Wt. Calib. field.

Move the cursor onto the lane region of the image.

=>The cursor form changes to   .

Click the lane you want to set as standard.

=>The Lane Attribute dialog box is displayed.

Click the Standard button.
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1. Molecular weight and isoelectric point calibration

Select a marker name.

=>The marker list is displayed.

You can register a new marker. Input the marker name and molecular weight,
then click the  button.
=> The New Marker dialog box is displayed.

Input a file name for the new marker, then click the [OK] button to register it.

The marker name registered is added to the list in the next analysis.

Bands checked in the Marker list are used for calibration. If any band is not used,
you can deselect it.
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2. Band concentration calibration

2. Band concentration calibration
You can set the band, the concentration of which is known.

Click the Profile, Quant, or Plate tab for calibrating band concentration.

Place the mouse cursor into the Density text box in the Density Calib. field, then input a unit

for quantitative values.

Click the  button under Select STD Band in Density Calib. field.

Move the cursor onto the quantifying region of an image.

=>The cursor form changes to the character B.

Click the quantifying band you want to set as standard.

=>The Band Attribute dialog box is displayed.

Single image Individual or overlaid images
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2. Band concentration calibration

Click the Standard button.

Input a standard value in the Know Density Value box.

Click the [OK] button.

Repeat Step  to Step  for each band you want to set as standard.

Click the [Calibration] button in Density Calib. field.

=>The Density Calibration dialog box is displayed.

Single image Individual or overlaid images
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2. Band concentration calibration

Select the curve function.

Select parameters for the vertical and horizontal axes of the calibration graph.

Click the [OK] button.

=>The bands specified as standard is displayed in yellow.
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Click the Analysis icon on the navigation panel to enter the Analysis mode.

This mode allows you to analyze the quantitative results, which are given as the results

table.

In the Analysis mode, image and results table windows are displayed.

The table format varies depending on the quantifying modes used.

To change the quantifying modes, click the desired tab.

The Analysis mode provides the following operation panel. The functions displayed in

the operation panel are same regardless of the quantifying modes.

Analyzing the quantitative results "Analysis mode"

Export the results table

Set items displayed on the results table

Sets the way to calculate the background

In addition to the results table that shows the quantitative results in order, optional

tables suitable for each quantifying mode are available.

(Quant) All.............. Display the quantitative results in order.

Comparisons......Arrange the quantitative results so that the corresponding

bands are adjacent to each other.

(Profile) All.............. Display the quantitative results in order.

Comparisons......Arranges the quantitative results so that the corresponding

bands are adjacent to each other.

(Plate) All.............. Display the quantitative results in order.

Comparisons......Arranges the quantitative results so that the corresponding

wells are adjacent to each other.

Plate.......Display the quantitative results in the same arrangement as the microplate.

(Distance) Display the results in order.
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1. Displaying the quantitative results.............. "Quant"

1. Displaying the quantitative results................... "Quant"
The Quant tab allows you to calculate quantitative values and display them in the results table.

Click the Quant tab on the operation panel.

=>The results table and image windows are displayed.

Switch the results views as follows.

Listing view
Click the All tab on the results table window.

=>Measurement values are listed.

Comparison view
Click the Comparison tab on the results table window.

=>Measurement values are arranged side by side on the group basis, which makes it easy to

compare the bands with each other.
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2. Displaying the quantitative results..........."Profile"

2. Displaying the quantitative results................... "Profile"
The Profile tab allows you to calculate quantitative values and display them in the results table.

Click the Profile tab on the operation panel.

=>The results table and image windows are displayed.

Switch the results views as follows.

Listing view
Click the All tab on the results table window.

=>Measurement values are listed.

Comparison view
Click the Comparison tab on the results table window.

=>The measurement values of each lane are arranged side by side, which makes it easy to

compare the bands with each other.
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3. Displaying the quantitative results.............. "Plate"

3. Displaying the quantitative results................... "Plate"
The Plate tab allows you to calculate quantitative values and display them in  the results table.

Click the Plate tab on the operation panel.

=>The results table and image windows are displayed.

Switch the results views as follows.

Listing view
Click the All tab on the results table window.

=>Measurement values are listed.

Comparison view
Click the Comparison tab on the results table window.

=>The measurement values of each well are arranged side by side, which makes it easy to

compare the wells with each other.
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3. Displaying the quantitative results.......... "Plate"

Plate view
Click the All tab on the results table window.

=>Measurement values are listed in the same arrangement as the plate, which makes it easy to

correspond to the image.
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4. Displaying the measurement results....................."Distance"

4. Displaying the measurement results.........................."Distance"
The Distance tab allows you to calculate quantitative distances and display them in the results table.

Click the Distance tab on the operation panel.

=>The results table and image windows are displayed.

Results table
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5. Selecting items displayed in the results table

5. Selecting items displayed in the results table
You can set items displayed in the results table and items for calculating the ratio.

Selecting items displayed in the results table
Click the results table window to make it active.

Click the  button on the operation panel.

=>The Table Option dialog box is displayed.

Select items to be displayed in the results table

Listing view

Check desired items in the List Item field.

Comparison or plate view

Click desired items.

Click the [OK] button.

Listing view Comparison or plate view

Items checked in the List Item field appear in the results table.
 

LAU... ........... Region intensity. LAU stands for Linear Arbitrary
Unit. The intensity unit depends on kinds of images.

Area(mm2)............................Regional area.
LAU-BG................................."Region intensity" - "Background intensity"
BG....................Background on the each region basis.
Ratio(%).................................. Ratio of the region to the sum of all regions

in each lane (which is 100%)
See below reference of Ratio.
When the check box in the Std field is
checked, the ratio of another region is
calculated, assuming that the ratio of the
checked region is 100%.

 
Reference of Ratio(%)............................Allows you to select the

reference for calculating the
ratios.
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5. Selecting items that appear in a results table

Setting items for calculating the ratio
Click the results table window to make it active.

Click the All tab on the results table window.

Click the  button on the operation panel.

=>The Table Option dialog box is displayed.

Select the value unit for calculating the ratios from the Reference of Ratio(%) field.

Click the [OK] button.

: This selection is enabled only when the listing view is chosen.

LAU/mm2 ................Region intensity per unit area.
(L-B)/mm2 .............. ("Region intensity" - "Background intensity") per unit area.
Dist ................................ Band migrating distance.
Da..................................... Molecular weight derived from the calibration curve in the Calibration mode.

The unit is one specified when the calibration curve was set. The lane used for
creating the calibration curve is displayed in yellow in the results table.

Density........................ Quantitative value derived from the calibration curve in the Calibration mode.
The unit is one specified when the calibration curve was set. The region used for
creating the calibration curve is displayed in yellow in the results table.
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6. Selecting a way to calculate the background

6. Selecting a way to calculate background
Set a calculation method of the background when multiple backgrounds are set.

Click the results table window to make it active.

Click the   button on the operation panel.

=>The Table Option dialog box is displayed.

Select a calculation method

Mean .............. Finds the mean value and uses the value as the background.

Median ........... Applies the median of the backgrounds.   When the number of backgrounds is

even, the smaller of the two median values is applied.

Minimum ....... Applies the minimum value of the backgrounds.

Click the [OK] button.
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7. Exporting the results table

7. Exporting the results table
You can save the results table as a text file or export the data through the Copy & Paste technique.

Saving the whole results table as a text file
Click the results table window to make it active.

Click the  button on the operation panel.

Input a file name to save.

Exporting part of the results table
Click the results table window to make it active.

Drag and select part of the results table you want to export.

Select the Copy command from the Edit menu.

=>The data chosen is copied in the clipboard.

Paste it to desired one.
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Click the Save icon on the navigation panel to enter the Save mode.

This mode allows you to save images and analyzing results.

The following saving modes are available.

Image

Overwriting

Saving as a different name

Saving in a different file format

Results table

Saving in the text file format

The Save mode provides the following operation panel.

Saving the images and results "Save mode"

Magnify the image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Display the

information of a pixel.

Overwriting.

Save as a different name.

Save in a different file format.

Magnify the image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Display the

information of a pixel.

Export a file.

<When the image window is active > <When the results table window is active >
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1. Saving images

1. Saving images
Images can be saved.

Click the image window to make it active.

Click the desired saving button on the operation panel.

a) Overwriting

Click the  button on the operation panel. The image is saved by

overwritting.

b) Saving as a different name

Click the  button on the operation panel. Input a name and save the

image.

c) Saving in a different file format

Click the  button on the operation panel, select one from the

following file types, change the file name if necessary, and save the image.

Original Image By Gray TIFF file (*.tif)..............................Saves as a gray tiff file with the same
number of pixels and bit image as the
original.

Original Image By Color TIFF file (*.tif)........................... Saves as an 8-bit color tiff file with the
same number of pixels as the
original.

Window Image By Color TIFF file (*.tif)........................... Saves as an 8-bit color tiff file with the
number of pixels displayed on the
monitor.

BMP Image File (*.bmp)......................................................................Saves as a color bmp file with the
number of pixels displayed on the
monitor.

* When a more than 8-bit image is saved as a color tiff file, the 8-bit color tiff is generated
from a range (between the right and left adjustors) specified by Range Scope.

: The saving function is disabled for the Profile window.

The Save and Save As buttons save the image with the analyzing results.
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2. Saving the results table

2. Saving the results table
The results table can be saved in the text file format.

Click the results table window to make it active.

Click the  button on the operation panel.

=>The results table is saved in the text file format.
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The Print and Print PICTRO icons on the navigation panel allows you to print out images and results

tables. The printing function is always enabled in any mode.

Windows able to be printed
The printing function is enabled only for image and results table windows. When images are

overlaid image, only the overlaid image can be printed out.

The printing function is disabled for the Profile window.

Printers usable
Printer having the printer driver (LBP, etc.)

=>Click the Print icon for printing.

Pictrography (3000, 3500, 4000, and PSD)

=>Click the Print PICTRO icon for printing.

Printing "Print" and "Print PICTRO"
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1. Printing out images

1. Printing out images
You can print out the image on the image window or the image on which quantifying regions, comments, arrows, and/or the

information file are put.

Select the Display Option command from the Edit menu.

=>The Display Option dialog box is displayed.

Check the Select Visible Entry Area option in the Entry Area Setting field.

Select the Always Visible check box in a mode in which you created some items to be printed

with the target image.

Click the [OK] button.

Click the desired image window to make it active.



2002. Oct. Ver.3.0 C-95

 Print, Print PICTRO

1. Printing out images

Click the Print or Print PICTRO icon on the navigation panel.

LBP
Click the Print icon.

Pictrography(3000, 3500, 4000, PSD)
Click the Print PICTRO icon.

=>The Print or Print PG dialog box is displayed.

Select Trimming.

Positioning or
Trimming

Output mode

Orientation

Centering

Output setup
Output size

Positioning or
Trimming

Centering

Output mode

Orientation

Output setupOutput size
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1. Printing out images

Magnify or reduce the trimming frame on the image window to set the desired printing area.

Select Positioning.

Click the Centering button.

=>The image is aligned with the center.

Clicking the Option button displays the Print Option dialog box, which allows
you to add comments and a tone bar as well as to finely adjust the printout

for higher recordability.

Specify an output mode, output size, orientation, and output setup or paper size, then click

the Print button.

Background setup for
comments

Printout fine
adjustment

Tone bar position

Comment entry box

Comment position
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2. Printing out a results table

2. Printing out a results table
The results table can be printed out.

Click the desired result table window to make it active.

Click the Print or Print PICTRO icon on the navigation panel.

LBP
Click the Print icon.

Pictrography(3000, 3500, 4000, PSD)
Click the Print PICTRO icon.

=>The Print Driver window is displayed. Note that this window depends on the printer

connected.

Click the  button.



2002. Oct. Ver.3.0C-98

 Print, Print PICTRO



2002. Oct. Ver.3.0

Part

D

Colony analysis



2002. Oct. Ver.3.0



2002. Oct. Ver.3.0 D-1

Part

D

Colony analysis

This is the function to mark the colonies of cultured fungi with RI, pigment, or fluorescent substances,
to capture the image through a scanner or CCD camera, and to detect and quantify the colonies.
The colonies can be detected automatically and be added or modified manually.

1.　About colony analysis　

1.　About colony analysis
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　2.　Starting up/ Exitting the Software

2. Starting up/ Exitting the Software

Starting up
The colony analysis is independent software. Double-click the Colony icon to start the software by same
manner as Malti Gauge.

Exitting
Select the Exit command from the File menu, and then determine whether or not to save a file before
quitting the software.
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3.　Operation flow with navigation　

3. Operation flow with navigation
The analysis goes step by step by clicking on the icons on the navigation panel.

Image mode

Allows you to open and trim an image.
↓

Display mode

Allows you to adjust the contrast of the image opened.
↓

Measure mode

Allows you to set measurement regions.
↓

Analysis mode

Allows you to detect, add, and modify colonies and display the measurement results.
Analyze the data obtained.

↓

Annotation mode

Allows you to put comments and arrows on the image.
↓

Save mode

Allows you to save the image and analyzing results.
↓

Print or Print PICTRO

Allows you to print out the image and analyzing results.
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Displaying an image "Image mode"

　4.　Operation Details

First of all, open the image you want to analyze in the Image mode.
The following two ways are available to open the image.

1. Open the image directly.
2. Trim the image, then open the trimmed.

The Image mode provides the following operation panel.

Magnify the image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Display the information
of a pixel.

Open the image file.

Trim the image.

Proceed to the next mode.
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4.　Operation Details　

Opening an image file....................................

The Open command allows you to directly open the file you want to analyze.

For in-depth operations, see "1. Opening an image file.................. " on
page C-2 of "Part C. Operation Details."

Trimming an image............................................

The Trim command allows you to trim part of the image you want to analyze and to open the
trimmed image.

For in-depth operations, see "2. Trimming an image" file ..................  on
page C-3 of "Part C. Operation Details."

Handling the image window

You can not only magnify or reduce the image being displayed but also switch the image
views.

For in-depth operations, see "4. Handling the image window" on page C-8 of "Part C.
Operation Details."
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Changing the view of the image　"Display mode"

Next, adjust the contrast of the opened image in the Display mode.
Click on the Display icon on the navigation panel to enter the Display mode.
The Display mode provides the following operation panel.

For in-depth operations, see pages C-11 to C-20 of "Step 2: Changing the view of
the image."

Magnify the image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Displays the information
of a pixel.

Change the color.

Enhance the contrast.

Proceed to the next mode.

Adjust the contrast.
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Set a measurement region.
Click the Measure icon on the navigation panel to enter the Measure mode.
The Measure mode provides the following operation panel.

 　Setting a measurement region　"Measure mode"

Pointer tool

Measurement region creation tool

Proceed to the next mode.

Background creation tool

4.　Operation Details　
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　4.　Operation Details

Setting a measurement region

Set the region for the petri dish to be measured.

1. Click   in the Observation Area field on the operation panel.

2. Move the mouse cursor in the upper left of the petri dish displayed, click the position
where the vertical and horizontal auxiliary lines are tangent to the perimeter of the
petri dish, and drag to the lower right.
Align the resulting circle with the petri dish, then release the mouse button.

3. If the alignment is not good in Step 2, modify the resulting region.

Movement
Place the mouse cursor on the region created.
=>The cursor form changes to  .
Press the mouse button, drag to the correct position, and release the mouse button.　

Size change
Move the mouse cursor onto the lower right dot ■ of the auxiliary lines of the region.
=>The cursor form changes to  .
Press the mouse button, drag the dot to magnify or reduce the region, and release the
mouse button.
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4.　Operation Details　

Splitting the measurement region

Split the petri dish region specified for measurement.

1. Click   in the Observation Area field on the operation panel.

2. Move the mouse cursor on the measurement region specified.
=>The auxiliary line is displayed, passing the center of the measurement region.

3. Move the auxiliary line, then click the position at which you want to split the region.
=>Division lines and numbers are displayed.

4. Repeat Step 3 to create necessary divisions, and finally double-click the mouse
button.
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　4.　Operation Details

Setting a background

Create a background region.

1. Click   in the Background Area field on the operation panel.

2. Move the mouse cursor onto the background region on the image.

3. Click and drag.
=>The region is displayed the starting point where the mouse button was pressed.

4. After determining the region, release the mouse button.
=>The background region is displayed.
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 　Measuring the image　"Analysis mode"

4.　Operation Details　

Detect, add, and modify colonies to display the measurement results, and analyze the data.
Click the Analysis icon on the navigation panel to enter the Analysis mode.
This mode provides the following operation panel.

Automatic region detection tools

Manual region modification tools

Magnify the  image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Display the information
of a pixel.

Sets the attributes of a region.

Sets items displayed  in a results table.
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　4.　Operation Details

Automatic region detection

After the criteria for detecting regions are specified, automatic region detection is executed.
Entering in the Analysis mode, automatic region detection is executed with the intial settings
and the result is displayed.

1. Set the density, size, and circularity in the Auto Detection field on the operation panel.
To change the values, place the cursor onto the desired slide bar and drag it.

2. Click the  button.

=>Detected regions are displayed in blue.

=>The measurement results is displayed in the results table.

Density:.....................Allows you to specify a colony density for
detection. Only colonies denser than the
specified are detected. The larger the value, the
denser the colony able to be detected.

Size:............................. Allows you to specify a colony size for detection .
Only colonies larger than the specified are
detected. The larger the value, the lager the colony
able to be detected.

Circulality:.............. Allows you to specify a colony circularity for
detection. Only colonies that have the circularity
rounder than the specified are detected. The larger
the value, the rounder the colony able to be
detected.
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4.　Operation Details　

Adding, splitting, or deleting the region

You can add, split, or delete the region manually. The changes update the results table
automatically.

Adding a region

1. Click the addition tool  from the manual region modification tools.

2. Select the width in the Width box of the Manual Edit field.

: The width is the diameter of the region to be added. The larger the value,
the larger the region.

3.  Click the point where the region to be added on the image.
=>The resulting region is displayed and filled with blue.

Adding a region by freehand

1. Click the freehand addition tool  from the manual region modification tools.

2. Select the width in the Width box of the Manual Edit field.

: The width is the thickness of the line to be drawn.

3. Press the mouse button at the desired point, then drag the cursor to create a
color-filling region.

4. Release the mouse button at the last point.
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　4.　Operation Details

Splitting the region

1. Click the split tool  from the manual region modification tools.

2. Select the width in the Width box of the Manual Edit field.

: The width is the thickness of the division line.

3. Press the mouse button at the starting point of the region you want to split, drag the
mouse cursor to draw a line which splits the region, and release the mouse button.

=>The region is divided into two.

Deleting the region

1. Click the deletion tool  from the manual region modification tools.

2. Click the region you want to delete.
=>The region is deleted.

The Undo command resets the last action.
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Modifying the attributes of the region

You can set whether or not to measure the region and input comments.

1. Click the  button on the operation panel.

=>The  button is held down.

2. Click the region, the attributes of which you want to change.
=>The Area Attribute dialog box is displayed.

3. Select any condition and input comments, then click the 

button.

4.　Operation Details　
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　4.　Operation Details

Setting items displayed the results table

You can specify items displayed in the results table.

1. Click the results table window to make it active.

2. Click the  button on the operation panel.

=>The Table Option dialog box is displayed.

3. Check desired items, then click the  button.

=>The results table is updated.



2002. Oct. Ver.3.0 D-17

Part

D

Colony analysis

 　Writing comments on the image　"Annotation mode"

4.　Operation Details　

The Annotation mode allows you to add arrows, comments, and file information on the image. This
mode provides the following operation panel.

For in-depth operations, see pages C-21 to C-30 in "Step 3: Writing comments on
an image."

Magnify the image.
Reduce the image.
Hand tool: Scroll the image.

Density Picker tool: Display the information
of a pixel.

Arrow tool

Text tool

Scale bar tool

Proceed to the next mode.

Pointer tool

Information tool
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　4.　Operation Details

Saving the image and results "Save mode"

Click the Save icon on the navigation panel to enter the Save mode.
This mode allows you to save the image and analyzing results.
The following saving functions are available.

Image
・Overwriting
・Saving as a different name
・Saving in a different file format

Results table
・Saving in the text file format

The Save mode provides the following operation panel.

For in-depth operations, seepages C-91 to C94 in "Step 7: Saving images and
results."

Overwriting

Save as a different name.

Save  in a different format.
Export the file.

<When the image window is active > <When the results table window is active >
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 　Printing　"Print" and "Print PICTRO"

4.　Operation Details　

Click the Print or Print PICTRO icon on the navigation panel to print out the image and result table.
This printing function is always enabled in any mode.

Windows able to be printed
The printing function is enabled only for image and results table windows. When images are
overlaid images, only the overlaid image can be printed out.
The printing function is disabled for the Profile window.

Printers usable
・Printer having the printer driver (LBP, etc.)

=>Click the Print icon for printing.
・Pictrography (3000, 3500, 4000, PSD)

=>Click the Print PICTRO icon for printing.

For in-depth operations, seepages C-95 to C-100 of "Step 8: Printing."
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